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Philosophy 
_____________________________________________________________________________________ 

Why do we use Students Achieve? 
Students Achieve is gradebook software. It is meant to assist teachers in tracking and calculating grades.  

Grading and reporting are two separate things that inform each other. 

With regard to grading, Students Achieve displays the scale that Saskatchewan Rivers School Division 
believes best supports student learning. Maplewood is not able to facilitate this choice. We use a 
(4,3,2,1) rubric for grades K-9 and a (4+, 4, 4-, 3+ …) rubric for grades 10-12 with a percent conversion at 
the overall course level only. 

Students Achieve has a Parent and Student Engagement Portal for reporting, but we still use 
Maplewood for our generating our paper based reporting documents that require attendance and 
comments.  

Understanding by Design – Usage by Design 
If you use Students Achieve as a gradebook, and not as a report card, your experience will be more 
satisfying. Weekly usage at a minimum, and ensuring each assessment is graded on the outcome(s), not 
the assessment qualities itself, will also yield an experience that is gratifying because the software will 
be complementing your practices rather than conflicting with them. 

Each outcome has its own column in the gradebook. Then at a reporting period, the software will pick 
for the teacher, the most recent mark for that outcome. Very rarely will a teacher need to apply 
professional judgement, unless you were actually marking different things under one outcome column. 
Ensuring each outcome mark is a reflection of the individual outcome you are marking and not 
something else will truly yield a mark that will should not need changing. The previous marks are an 
indication of growth, or consistency, you can use them to communicate, inform, and provide a record of 
learning, but if you are marking more than one ‘thing’ in one column, the summary won’t support your 
thinking. 

Philosophy Support 
Looking at current and emerging practice in other Canadian school divisions can be very re-affirming. 
We are not alone. The Integrated Learning Department website has a Students Achieve philosophy page 
with varying support documents that have been shared at past assessment workshops. Many school 
divisions across Alberta, Saskatchewan, Manitoba, and Ontario use Students Achieve for their outcomes 
based reporting.  
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Parent Section 
_____________________________________________________________________________________ 

Communicating Student Learning 
Ongoing communication between teachers, students and parents informs and supports learning. The 
use of quality feedback ensures that teachers, parents and students clearly understand the learning 
targets.  Parent involvement in discussing feedback and can support the student’s progress towards 
learning outcomes. Effective communication practices already in place have now been expanded to 
include the Engagement Portal, an online venue for parents to be informed about how their child is 
doing at school.  

Assessment and Grading  
Daily, ongoing assessment and report cards are not separate. They inform each other. Both are based on 
outcomes from the provincial curricula and inform next steps for learners and teachers. During a unit of 
study, students have multiple and varied opportunities to develop, demonstrate, check and refine their 
understanding of content. This process is called formative assessment. At times, often at the end of a 
particular unit of study, the learning of a student is verified through a summative assessment. Teachers 
then use multiple summative assessments aligned with outcomes from the curriculum, to assign a 
'grade'.   

Formative assessment: checking learning to decide what to do next  

Summative assessment: a comparison at a particular moment in time between individual student 
achievement and the outcomes of the Provincial Curricula. 

Formative assessment supports learning, summative assessment verifies learning, reports card grades 
summarize learning. The Engagement Portal will show you all three. 
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Outcomes Based Reporting 
Saskatchewan Rivers Public School Division is shifting toward a new vision for education which 
promotes competencies for today’s world and for the future. The direction of our provincial curricula 
as well as current research on assessment, evaluation and student learning, require us to work 
together to understand and communicate about student learning in new ways. Like many other school 
divisions in Saskatchewan and across Canada, SRPSD is re-designing assessment and reporting practices 
to reflect these new directions. 

We are expanding the outcomes based grading model from the current grades K-9 up into grades 10-
12.  Indicators based on rubrics provided to your child are used to represent the extent to which the 
student has demonstrated achievement of learning outcomes. The rubrics for Kindergarten to grade 9 
are assessed on a 4,3,2,1 scale. The rubrics for grade 10-12 include a high and low level at each rubric 
mark. This high and low is designed to assist with summarizing and calculating a required percent grade 
for the Ministry of Education.  

Indicators of Achievement for Kindergarten to Grade 9 
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Indicators of Achievement for Grades 10-12 
 

 

Characteristics of Successful Learners K-12 
Skills such as working with others, following directions, punctuality and participation are important for 
success in life. At SRPSD those skills are reported separately from academic achievement. There are 
four characteristics of successful learners as follows:  

Confidence 
Welcomes new opportunities; perseveres when met with challenges; is invested in learning. 
Citizenship 
Respects others, rules & property; is caring & trustworthy; conducts self with dignity. 
Responsibility 
Exhibits personal and academic independence; takes responsibility for own behaviour; resolves 
conflict. 
Work-Habits 
Works effectively with others; completes and turns in assignments; comes prepared to class. 
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Indicators of success for Characteristics of Successful Learners 
C – Your child consistently demonstrates these characteristics.  

U – Your child usually demonstrates these characteristics. 

S – Your child sometimes demonstrates these characteristics. 

R – Your child rarely demonstrates these characteristics. 

Parent Frequently Asked Questions 
How does a teacher use multiple assessment tools to determine a final grade? 

Assessment consists of a variety of conversation, observation, process-based and product-based forms 
over time. These multiple forms of assessment determine the extent to which learner outcomes have 
been demonstrated by your child. 

Rubrics are clearly outlined sets of criteria that explain what a learner should know and be able to do. 
Throughout a unit of study a teacher will use a variety of assessments (rubrics, labs, tests, 
performance-based, observations, feedback, conversations, quizzes, portfolios etc.) At the end of their 
unit of study, students and teachers can assess progress in reference to the criteria, and decide on next 
steps in learning. A teacher then uses the most recent evidence of achievement to determine a final 
grade. 

Why is there no percent mark on the grade 10-12 courses until the end of the course? 

The teacher view and student or parent view are all aligned. Teachers nor students use % marks to 
inform instruction. The overall % is a final calculation made at the end of a course for reporting to the 
ministry of education. When it is calculated, it is made available to all. It is not available to any 
stakeholder prior to year end. Students need to be encouraged to focus on the outcomes and 
improving their attainment of the concepts in each course.  

How will behavior, punctuality, and participation be graded? 

Skills such as working with others, following directions, punctuality and participation are important for 
success in life. At SRPSD, such skills are reported separately from academic achievement through the 
four Characteristics of Successful Learners or CSL’s which are Citizenship, Confidence, Responsibility, 
and Work Habits.  

Who do I contact if I have questions or comments about reporting and assessment practices at my 
child’s school? 

Contact the school principal to share any comments or discuss any questions you might have. 
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Teacher Section 
_____________________________________________________________________________________ 

Internet Based – Web Based Software 
Students Achieve is viewed through a web browser. You can use any browser…but they will all give you 
different views.   It’s like Students Achieve is the landscape outside your window…out there on the 
Internet.  You might view it through sunglasses, or a windshield, or a scratched piece of plexiglass.  
Moral of the story – whenever possible use Chrome as your browser instead of others. It provides a 
better user experience. Students Achieve is designed on Chrome, and then tested for functionality on r 
Safari, Firefox, and Internet Explorer (in that order). We would still like to know about bugs in certain 
browsers to fix them, but in any immediate need of help, try a different browser if you feel it is not 
‘looking’ right. This is a symptom of the Internet itself and is true for many different websites.  

Clearing your Internet Explorer Cache 
Sometimes you need to clear your browser cache to get rid of your machine remembering old, and 
therefore bad links.  

Click the tiny cog in the upper right hand corner, choose Internet Options from the list. 

 

 

 

 

 

 

Click Delete (if you want this to never happen again…check the box 
delete browsing history on exit…but that also means IE won’t save 
your passwords for anything…convenience factor)  

 

Uncheck the top box and leave the rest alone and hit delete. 

 

After hitting delete it will take you back to the first picture….click 
Apply and OK and then Close internet explorer. When you go back in 
next time you are good to go. 
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Logging into Students Achieve 

From school 
From www.srsd119.ca , click SRPSD Staff.  

Inside the staffroom, click the purple Students Achieve icon.   

This will get you to this website: https://sas.srsd119.ca/SASTeacherWeb/  

All login credentials are tied to your regular SRPSD login information and Maplewood. Contact Rochelle 
in the Technical Services department at rlennox@srsd119.ca for login issues.  If your class information or 
school information is incorrect, contact your school secretary. 

Create a shortcut for easy access 

Once you have gained access, feel free to drag the tiny favicon, or little blue stepping stones at the 

beginning of the URL ( ) to your desktop or taskbar. This will 
create a permanent shortcut straight to Students Achieve. 

From home 
Follow the same instructions as from school, and expect to be prompted to enter your SRPSD username 
and password. 

The windows security box is where you login. If you are having trouble at home, ensure that the word 
Domain says srsd119.ca and not something like homepc…to change it put an @ in your username, or use 
your whole email address – the Domain is actually made up of the letters after an @ symbol in a 
person’s username. 

If you get the Students Achieve login screen something is wrong, clear your browser cache and try again, 
or go directly to https://sas.srsd119.ca/SASTeacherWeb/  
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Other setup information 
Maplewood ‘talks to’ Students Achieve nightly. Maplewood sends teacher, class, and student 
information to Students Achieve, but it never ever takes anything away from Students Achieve. 

You will see at the top of your Students Achieve screen your options. You won’t be able to change your 
school, unless you work in more than one school. You won’t be able to change teacher unless you are an 
administrator of Students Achieve, and everyone can change years to view previous data. 

 

 If you don’t appear in the teacher list, request that your school secretary add you as a teacher in 
Maplewood. OR if you simply share assessing in a class, ask the main teacher to share with you. 

If you appear in the wrong school, or multiple schools when you shouldn’t, contact the school secretary 
of the school you do not wish to show up in, request you be removed from their Maplewood teacher 
list. 

If the classes in the class section list are not all the ones you teach, request that your school secretary 
add those classes to Maplewood for you. 

If the incorrect students are in your class, request that your school secretary fix the timetable for the 
students into your class in Maplewood.  

Any changes to Maplewood the school secretary makes will be reflected in Students Achieve the next 
morning. If a change is urgent, please have the school secretary contact a Students Achieve 
administrator to perform a mid-day integration rather than waiting overnight.  

Keeping in mind that Students Achieve does not ever delete information, sometimes at the beginning of 
the year you can get duplicate classes. If you have two copies of one class, delete them both and only 
the correct one will come back the next day. See Managing Class Sections for instructions.  
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Shortcuts 
All Shortcuts on the middle of the page are also found in the tabs at the top of the page. 

Input Classroom Attendance – is a one click link out to Maplewood to do your attendance.  

Touch Marks Entry – the fastest, clearest 
way to enter marks. It is used mainly at the 
point of entering marks. Looking at the 
Touch Marks Entry screen to find old or 
future assignments can become 
cumbersome as many get entered. Touch 
Mark Entry is the ONLY way to use cross 
curricular marking and to be able to edit 
assignments by adding or removing 
outcomes. 

Plan Classroom Assignments – an older but 
valid way to enter marks. This area is the 
best place to look at a list of all 
assignments, easily rename assignments, or 
check if things are summative, formative, 
or make changes.  This area will be phased 
out as the new Touch Marks Entry system 
gains features over the next few years. 

Student Analysis - the overall view of 
summative marks and the reportable 
overall marks for a student. Student 
Analysis also is where you can print marks 
verification sheets and various reports. 

Assessment and Evaluation Database – is a link to the SRPSD databases for entering math common 
assessments and DRA marks. 

Enter Comments and Review Report Cards - is a link to Maplewood for teachers to see the results of an 
export, and to type comments. This is where programming codes are entered.  
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Manage Class Sections 
For the very first time use of Students Achieve, you need to initialize your class. This means you are 
telling the software which outcomes you need aligned to which class. You are essentially confirming that 
the SOC or Social curriculum does indeed go with your class. This is an automated process, but the 
teacher needs to confirm by clicking initialize, and looking to see if indeed the right curriculum is there.  

Your understanding of the implications of this process is essential because if you do start putting 
assessments for the year in your class and you do not have the correct template assigned, the only way 
to fix it is to start over.  

Initialization is just as simple to verify as it is important to do. 

• Click Manage 
o >Classes 

 >Class Sections in the menu. 

 

 

A screen with all your classes will appear. Follow the row across from the class you wish to set up to the 
template name column.  

• Click the underlined word initialize in the template name column. 

Immediately after clicking Initialize, you will be able to choose your strands for your curriculum for the 
ENTIRE YEAR! Check off all boxes for your grade, or for multigrade, check off the grades you require.  

 

Do NOT click select all! It will give you like 6 grades. Just check the boxes you need…all strands for your 
grade. 

Yahoo – it worked…..but what did it do? How do you know you did it correctly? Go make an 
assignment…do you have the correct curriculum for the whole year? If so, congratulations, keep calm 
and assess on. If not, tell your school students achieve expert immediately. The instructions for de-
initializing, or resetting your template are found in the expert section under Manage Tab. 
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IF it did not say course configuration copied, it will give you a message. Read the message, and send the 
information to your school secretary. Common issues are:  

• Course not found starting after 9/2/2014 or some date. This means the date the course starts in 
Maplewood does not match the terms set up for the school.  The secretary must check the 
dates the course starts and if they do match, call their support person to contact Students 
Achieve. 

• Course code ‘XXX10’ not matching. This should not happen in 2015-16, but if it does, let your 
secretary know. We are pushing the proper codes out to all schools rather than having schools 
enter codes that match…so they should all match.  
 

When you get the configuration copied message, if you want to see the template applied, you need to 
refresh your screen. Hit F5, or the cycle icon to refresh your screen – then you will see the template you 
were assigned.  
 
There are 5 templates that could get assigned: (or 6: French Immersion K-2 coming soon) 
 

1.) Elementary Subject Template 
a. This template is for all Grade 1-9 subjects except PAA. It should simply initialize and 

give you no choices. It will also give you a 1,2,3,4 scale. 
2.) High School Subject Template 

a. This template is for all Grade 10-12 subjects except PAA. It should simply initialize 
and give you no choices. It will also give you a 1-,1,1+,2-,2,2+,3-,3,3+,4-,4,4+  scale 
with final % conversion for ministry mark exporting. 

3.) Kindergarten Template 
a. This template will give you a 1,2,3,4 scale, and NO CSL, or Characteristics of 

Successful Learners per subject like grade 1-9 uses. It should simply initialize and 
give you no choices. 

4.) High School PAA Template 
a. This template is for all Grade 10-12 PAA subjects. It should ask you which PAA 

strand(s) your class is. Choose ALL strands that the students in your class will receive 
for their WHOLE year. If those kids switch between ‘home ec’ and shop’ you will 
need to choose clothing, and food, and construction, and drafting. You only choose 
one ‘strand’ if you are teaching a pure course. Even if you are just the ‘home ec’ 
teacher.  It will also give you a 1-,1,1+,2-,2,2+,3-,3,3+,4-,4,4+  scale with final % 
conversion for ministry mark exporting. 

5.) Elementary PAA Template 
a. This template is for all Grade 7-9 PAA subjects. It should ask you which PAA strand(s) 

your class is. Choose ALL strands that the students in your class will receive for their 
WHOLE year. If those kids switch between ‘home ec’ and shop’ you will need to 
choose clothing, and food, and construction, and drafting, even if you are just the 
‘home ec’ teacher. There are no pure courses at this level, the minimum is 3 strands.  
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If you believe you have the wrong template applied, tell your school students achieve expert 
immediately. The instructions for de-initializing, or resetting your template are found in the expert 
section under Manage Tab. 

IF the program asks you which strands or grades you want in a regular non PAA class, you are 
unfortunately accessing students achieve during a time when initialization has been turned off automatic 
mode so that multi-grade classes can be set up. Please proceed carefully choosing the entire curriculum 
for your whole year in the correct grade only.  

 

Renaming class sections 
It may become hard to keep track of your classes because of the way 
they are named in Maplewood, you can change them to a nicer view for 
yourself. 

In this picture there are two ELA A10’s – A section a and c. If that was 
your semester 1 vs. semester 2 class – it would be nice to name them 
that way. 

 

1.) Click Manage, Classes, Class Sections.  

 

 

2.) Click the tiny paper and pencil button beside the class you want to change. 

3.) In the Label row, type what you wish. Please leave the section letter – the a or d or q there for 
your admin.  Maybe Sem1-Physics 30a… 
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Removing class sections 
Check the empty box beside the class section that you no 
longer teach or want to see, and choose delete. It will go 
away (unless you have marks or assignments in which 
case you will have to clear it first.  

If that class is still timetabled to you in Maplewood, it 
will come back the next day.  For this reason, at the 
beginning of the year, if you have more than you should, 

it is acceptable to delete them all and see what comes back the next day. This only works before you put 
in assignments. 

 

Verifying Maplewood Topic Selection 
 

Topics in Maplewood selected for your course WILL print on the report card. The secretary at the school 
has many topics to match to many classes, and it is the teacher’s responsibility to notice any errors prior 
to entering comments in Maplewood as it cannot be fixed after the teacher’s initial entry. 

• Open up Maplewood. (Through the staff room web link or through the shortcut menu in 
students achieve item says ‘Enter Marks and Review Report Cards’) 

 

• Click Enter Marks/Comments by Class 
 

• Look at the Topics listed. Do the underlined blue words that will PRINT on your report card look 
correct? If so, buy your secretary a coffee…there are lots of topics to choose from!  If not, you 
might want that coffee anyway when you go tell your secretary the topics are incorrect. Use the 
word ‘TOPICS’ and she will know how to assign the correct topics to your class. 

• Open up students achieve and go to the student analysis screen. By clicking STUDENT ANALYIS 
from the main list of shortcuts. 
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• Look at the overall strands that are there. Hover over the short code to get a full description. 

Compare them with the topics you have in Maplewood. If they match, you are golden. If they do 
not match alert your secretary.  

NOTE: All high school classes grade 10-12 will additionally have the topic Grade.   
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Sharing Classes 
 
Step 1:  From the Students Achieve Blue Tabs select ‘Manage’, ‘Classes’ and then ‘Class Configuration’ 
 
 
 
 
 
 
 
Step 2:  Select the ‘Sharing’ Tab and decide whether you will provide ‘Read Only’ or ‘Full Access’. 
 
 
 
 
 
 
 
 
 
 
Step 3:  Click on ‘New’ 
& select a ‘Teacher’ 
and then Click ‘Finish’  
 
If you do not see the 
teacher in the list to 
select, it is because 
they have no classes 
yet. Check the Filter 
by Date box, and all 
staff will appear to 
choose from.  
  
  
  
  
  
         
   
 The Shared Class(es) will appear in the Teacher Class Drop Down with an ‘S’ next to the Course Code. 
 
 
To “Unshare” or Delete a Teacher as a Shared User, Check the Box to the left of the name and click 
‘Delete’ 
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Touch Marks Entry (non-touch screens too!) 
 

Creating an Assignment 
 

1.) Click Touch Marks Entry from the shortcuts menu  
 
 
 
OR from the top menu under the ASSESS tab, Classroom 
tab, Touch Marks Entry.  

 

2.) Choose the class you want to create an assessment in from the top drop down area. 

 

3.) Click New Assessment from the Touch Marks Entry (TME) top menu 
4.) Fill out the new assignment wizard 

 

 
 

Clicking save in the new assignment wizard will close it and you will be at the marking screen. 

Choose One 

Choose One 

Enter an 
estimated 
date 

Check any boxes that 
apply and hit save 

The plus allows for 
cross curricular 

Leave Alone 

Type Title 
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Marking an Assignment 
Touch Marks Entry is a simple click and fill or touch and fill on a touch screen. YES you can use Touch 
Marks Entry on a NON-Touch screen!  In the Fall of 2015 it will also facilitate keying in marks with the 
number pad and tab key as an improvement. 

The top menu in Touch Marks Entry will change automatically as soon as you touch an area to mark.  

Normal top bar: 

 

Touch an empty outcome box inside your gradebook – and the top menu looks like this: 

Elementary K-9: 

 

High School 10-12: 

 

Touch an empty Characteristic of Successful Learner box – and the top menu looks like this: 

 

You cannot touch/click/highlight an outcome box AND a characteristic box at the same time. The 
offending box will flash red and simply not allow it to happen.  
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Auto  Filling vs. Marking student by student. 
If a cell is light blue, that cell will be filled with whatever number 
you choose as a mark. 

To auto fill an entire column click the title of the column.  

 

To choose just individual cells, click as many of the same type (all 
outcome or all CSL) as you wish, even across different assignments. 

 

If you are entering marks student by student, you will want to 
uncheck the show all students check box so that just some of your 
students are showing. This displays a few kids at a time with a down 
arrow above their names, so you can still go to any kid in your class…but you can see the top menu bar 
for every kid, even the ones at the bottom. Thus unchecking this box eliminates the constant scrolling 
that can happen with kids at the bottom of the class and marks available only at the top of the screen.  

Only one caution:  Autofill will only fill in the kids on the screen not the whole class if you have show all 
students unchecked. 

Other features of the touch marks entry screen 
• The up and down arrows will show your class list page by page, or if you check the show all 

students box on the top menu, they will be greyed out because all students are on one screen. 
• The tiny i gives you more information about an outcome. 
• The comment column will allow you to put an individual comment on one assignment for one 

kid. These are not report card comments. Currently they do not show on the portal, but if 
teachers want, that can be turned on to communicate with parents via these comments. 
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Importing an Assignment 
 

Inside Touch Marks Entry start in the class you 
want your new assessments to LAND IN, or the 
one you want them copied to.  

• Click the Import Assessments button in 
the top menu.  

• Choose the track or year you want to 
copy from  

• Choose the class you want to copy from 
• Choose the assignments you want to 

copy. The top check box will choose all. 
• Hit Import. 

In this picture – I am copying two assignments 
from my Science D class to my Science R class which I selected to start with. 

This is the pop up box that will list each assignment that you are copying, and the blue bar at the top will 
show progress. When the bar is complete and it says done, you close the box. Your assignments then 
just appear in your touch marks entry screen ready to mark with your new class. The date will 
automatically be the date you imported. In most cases 
you will have to go change the dates. To save yourself 
time, you can just import when you need the 
assessments, rather than picking a day at the start of 
the year and just importing lots of assignments from 
last year. If you do that all at once your touch marks 
entry screen will be huge until you change your dates. 
You’ll also have to change portal visibility if you don’t 
want them to show up in the list yet. 

 

 
Note: you used to be able to copy assignments in the old plan class assignments section,  that does not 
work any longer, you must use the import feature to copy assignments from previous years.  

 

Check to make sure your assignment has the parts it needs. If it had old curriculum and the curriculum in 
students achieve has changed, then you should not copy as the outcomes will be different. If a copied 
assignment does not show up in the student analysis, or the marks appear not to count call your 
students achieve expert to get your copied assignments re-aligned.   
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Transferring Student Marks 
If a student comes to you from another SRPSD school you may 
have hit the jackpot! You can transfer marks into your classes 
from any like classes this student has taken.  

Pick your own class from the top drop down.  

 

 

Then from the top tabs choose  

• Assess>Classroom>Transfer Student Marks. 

 

 

A new pop up window will appear.  

• In the first selection box, select the class you are importing into: your class. 
• In the second selection box, choose the student from your list. 
• IF the student selected has taken that class from any other SRPSD school at any time in the past 

5 years, the last selection box will fill up.  
• Click Next. 

In this example, this student has never taken 
another Math 3 class in our division.  

 

 

 

 

 

 

In this example this student has taken PE 9 previously with 
another teacher.  
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Cross Curricular 
Whatever class you make your assignment in is the ONLY class you will be able to see it in your 
gradebook and enter marks in. This means your ‘ELA’ assignment with Health, Arts, and PAA outcomes 
will appear only in your ‘ELA’ gradebook. You will not see a duplicate in your Health gradebook for 
example. However it is working! If you proceed to the Health or Arts Student Analysis screen and open 
up the assignment level with the + sign, you will see your marks counting for that course.  

 

 

 

 

 

 

 

The Touch Marks Entry screen in the ‘ELA’ class in this example will have 
the outcomes from all cross curricular areas selected.  

 

 

 

 

DO NOT use Cross Curricular across different 
grades. (make new assessments)  

 

 

 

 

Do NOT use Cross Curricular for different sections 
of different kids. (use import assessments instead) 
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Deactivating an Assessment 
 

Click on a student and choose ‘Deactivate Assessments’ to deactivate an assessment for a student.  Click 
the same button to Re-Activate the assessment as well. (light blue is active, greyed out is de-activated) 
 
IF the student has marks: 

• This will be viewed as a grey color in the Student Analysis Screen and the Portal.   
 
IF the student does not have any marks: 

• The assignment will disappear altogether from the Student Analysis Screen and the Portal. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 

 

Controlling Portal Visibility 
Click on the name of the assignment and choose Parent 
Portal Visibility from the drop down menu. 

 

 

This will allow you to set both an assignment visibility date, and the results 
publish date by choosing from a calendar that will pop up when you click in the 
empty date box, or by choosing today or never.  

The results publish date is meant to allow you to mark some students one day, 
some another day, and have all students see their marks at the same time.   
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Student Name 

Student Analysis 

Navigating to Student Analysis 
 
Student Analysis is a shortcut on the main screen. 

OR  

You can also use the main tabs at the top.  

Analyze>Classroom>Student Analysis 

 

OR 

Click on the student name in the Touch Marks Entry screen and 
choose Student Analysis from the drop down box.  

 

 
 
 
 
The Student Analysis area has two main functions: 

1.) Generating reports for marks verification, student handouts, or interim reports. 
2.) Applying Professional Judgement to obtain the desired strand mark. 

 
 
 
 
 
The menu bar for student analysis has a drop down choice for 
different classes, and for different students. Simply choose your 
class and student.  

 
The menu bar also has the results analysis where you can see what 
marks will go on the report card and apply professional judgement. 
 
Your choices will be an outcome analysis and a characteristic of 
successful learner analysis for each term. 
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Viewing Data 
Once you have chosen your class/student/term using the above pictured drop down arrows, then your 
screen will reflect that data. 
 
This image has all the pop up and hover over items showing.  
 

 
The BOTTOM line: Strand Result – is the only line that exports to Maplewood. 
 
Overall outcome marks reflect the most recent learning. 
 
Overall strand marks reflect the average of all outcomes in that strand.  
 
If an overall course mark is there (Grades 10-12) it will be an average of all outcomes, regardless of 
strand.  
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The most underused and neatest feature of Student Analysis 
is the +/- button.  You can see as much or as little as you 
want by clicking + or -. 
 

+ You can see assignment level in addition to Outcome level 
You can simplify down to strand only by clicking the – as well 
 
 
You can click inside a drop down box in any Professional 
Judgement line and make your choice. That choice will 
display in subsequent terms as well so you don’t have to 
remember it. This picture has a Previous Term Professional 
Judgement line. 
 
 
The Assessments are organized by date. You can hover over each name and see the date, you can 
hover over each mark and see the outcome, description, and completion code. 
 
The Outcomes display the most consistent and most recent from a single outcome column of all the 
assignment parts that referred to that outcome. Only if the most recent and most consistent are 
different should you apply professional judgement. It should not be used to insert your own average 
number or ignore growth. The outcome result defaults to the most recent by design. 
 
The Strand section shows the average and most consistent, gives you professional judgement there too, 
and the overall strand result is the average of all outcome result marks for items in that strand.  
 

Quick Tricks looking at data 
 
Try the student summary report for a quick view of all students to see if any most consistent and 
average marks are different…this saves going student 
by student by student….you can see which 3 or 4 kids 
actually require professional judgement rather than 
looking at each student.  
 
The student summary has many filters on it…you can 
switch to outcome, and pick one outcome and look at 
the overall results for all assessments on that 
outcome.  Just click VIEW to see the results. 
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Overall Result Analysis – High School 10-12 only: 
Kindergarten to Grade 9 classes do not calculate a percent at any time. Grades 10-12 classes will give 
you an overall analysis at the end of the term so you do not have to calculate a mark for the Ministry by 
hand.   
 

 
This example shows that even though we never give a zero on assignments, we don’t mark 
assignments….we mark outcomes; outcomes not attempted at all will lower your overall mark. 
 
This is not automatic. You cannot give a zero as a grade. In the overall course analysis where you create 
a percent, you can use your professional judgement as a teacher to zero out any outcomes that you 
have no evidence for.  
 
The message for students is that every outcome matters. Attempting and aiming for mastery on every 
outcome is how we learn and demonstrate learning. 
 

As a teacher, you encourage students to do something, anything, to show their skill or knowledge with 
that outcome. We encourage, we differentiate, we re-teach and provide opportunity to learn, but when 
they have not shown evidence of anything, there is recourse. When it is time to assign a mark for the 
course in its entirety, and you have no evidence at all in any outcome, you can add a zero to an outcome 
mark and it will lower the percent calculation.  
 
You can also put N/A into the professional judgement for outcomes that you did not teach, did not 
expect that student to do, or for outcomes that are optional and should not be factored into the percent 
calculation. N/A will not lower the student’s mark. Zero will lower an overall term result. 
 
The percent is calculated by averaging each outcome’s mid point value from the teacher view 
conversion chart. The strands have nothing to do with % calculation as there can be an unbalanced 
number of outcomes in a strand. 
 
This example of 6 high 4’s and one low four and 6 zero’s is: 
(98+88+98+98+98+98+98+0+0+0+0+0+0)/13 = 52 
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Reports in Student Analysis 
 
 
The tiny word reports under the analysis choices will get you to various 
printable reports for students and parents and marks verification. 
 
The current list of reports that pops up is ridiculously long and not 
descriptive. This list is changing over the summer so as it changes reports 
will be more properly described. Time will definitely yield improvements 
here.  
 
Reports with the words (all students) after them will do the whole class, 
the one named the same without all students will do the same thing for 
a single student.  
 
The Marks Verification Summary is simply the Class Section Summary for 
ALL classes a teacher teaches. 
 
So if you are trying to verify your marks that will be exported, use the 
Class Section Summary if you prefer to do it class by class, or the Marks 
Verification Summary if you want one print job with every class you 
teach. For both of those options run them once for outcome marks and 
once for CSL marks.  
 
Click on any report.  
 
Notice the options available in the top bar, each time you change 
options, click VIEW to see your new results. Many reports themselves 
have different options within them.  

 
Click Save as PDF to save the report to your computer and print. Notice 
you have the option to have the report display portrait or landscape and 
can check the colour box to have it saved with colours. 
 
 

 

 

Any desired reports can be requested. If you really need something here 
you don’t see, send a hand drawn/typed/or photo of what you want and why to your students achieve 
expert and it can be determined if that will be paid to be developed.  
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Kindergarten Report Card 
Kindergarten teachers use Students Achieve to enter outcome based marks but NOT Characteristics of 
Successful Learner marks.  

In the past Kindergarten teachers have been responsible for attaching a word document with the 
Kindergarten Specific CSL marks to a report card. Now you do this in MAPLEWOOD. 

Kindergarten teachers do not do programming codes. (NEW) 

Term 1 ONLY has CSL marks, Term 2 and 3 will have both outcomes based marks AND CSL marks. 

What do K teachers actually do for term 1? 
 

 Consistently keep appropriate outcome achievement data in students achieve as in the past. 
 

 At report card time, use the  button to 
get into Maplewood. 
 

 Click Class Achievement 
 

 Choose your Social K class 
 
 

 Enter the CSL marks directly into Maplewood in the empty boxes for each reportable CSL. 

 

 

 

(hover over the topic titles for a pop up to appear. Don’t click on the topic titles. Just click in the empty 
box to choose C,U,S,R  for Consistently, Usually, Sometimes, and Rarely.  To ‘autofill’ ensure your cursor 
is in a box with a letter pre-chosen you want, and hit Shift-ctrl-down arrow.) 

 Enter generic comments in the Social Studies class comment box.  
 
 
 

 
 Print the Kindergarten report card on LETTER paper. Choose Kindergarten CSL only for term 1. 
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Engagement Portal  

Background Information 
Students Achieve as you know it sits on one website.    
https://sas.srsd119.ca/SASTeacherWeb/ 

The student engagement portal which facilitates student authenticated login via SRPSD computer 
username and password sits on a DIFFERENT website.https://sas.srsd119.ca/SASStudentWeb/. The 
parent engagement portal which facilitates parent authenticated login via generated usernames and 
passwords, sits on a DIFFERENT website https://sas.srsd119.ca/SASPublicWeb/ 

You as a teacher, can go look at the student or parent view any time you wish, from your own SA 
teacher website, without logging in as anyone else. 

Checking Portal View 
• Click Manage 

o People 
o Parents …from the main menu. 

 

• Click on the paper pencil icon beside the desired Parent. 

 

• Click on the Website Tab 
• Click Launch Parent Website 

 

The Portal shows Achievements as the overall snapshot just like the report card, but it is interactive, so 
everything you click will go deeper to show either the assessment itself or the outcome. Students and 
Parents can see completion codes and marks for assignments, and outcome and strand overall results.  

There is a legend and people can reset their password under My Account.  

To see the last date a parent or student accessed the portal, go to Manage, People, and find the person. 
There is a column beside their name titled LAST LOGIN. It has dates and can be sorted by date.  
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Plan Class Assignments (OLD – to be discontinued in coming years) 
 

The Plan Class Assignments view is being replaced slowly by Touch Marks Entry (TME). As far as simply 
entering marks, TME is better all around, but the old view has value in: 

• Making and using folders to organize yourself 
• Being able to see all assignments on one screen, regardless of date.  
• Changing formative to summative quickly for multiple assignments 
• Previewing to see if all strands or all CSL’s have been covered 

The new TME view will eventually have all these features and at that point Students Achieve will get rid 
of this old view. Until then, use it for its valued pieces only. 

Creating an Assignment (OLD, use Touch Marks Entry when possible) 
 
Step 1: Select the course you want to work with using the drop down arrow. 
 

 
 
 
 
 
Step 2 : 
 
 Select “Plan Classroom Assignments” from the 
Shortcuts Menu. 
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Step 3:   Choose a Folder. 
 

 
 
 
 
If you click the edit checkbox you can change the names of existing folders. 
 

 
 
If you click new – there are cabinets or exam folders…just stick with lesson 
marks folders please. 
 
 
Please note that just because you name a folder: Term 2, those marks 
will not just go into Term 2 – the dates of the assignments have to fall within the Term 2 date range. 
You might even be better off to name your folder “Life Science” or “Growth Plans”.  
 
Here is a sample picture of someone’s chosen folder structure:  
Do what suits you. Having multiple folders lets you see fewer things on the screen at a time. 

 
 
 
Step 4: Click New – to create a new assignment. (once inside a folder) 
 
 

 
 
Step 5: Complete the assignment wizard. 
 

Assessments is the only 
folder there to start 
with. Feel  free to click 
New to create new 
lesson marks folders 
and name them what 
you want. You can also 
rename the assessment 
folder. 
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Select the 
Outcome(s) that 
you are assessing.  
Note, if more than 
one outcome is 
selected, an 
evaluation will be 
required for each 
one individually.  

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
**Hovering over the outcome number will show you the entire outcome wording.  
 
Next you may choose to assess none, one, or more than one of the Characteristics of Successful Learners 
for this assignment.  
 

Type a name.   

Anything 
identifying this 
assignment for you 
will do. 

Click icon to pop 
up a calendar to 
choose your date. 
Date is not 
required, but 
recommended as 
marks are 
calculated based 
on most recent 
improvement.  

Choose what type your 
assessment will be. Throughout 
the year you want to strive to have 
a balanced or triangulated 
portfolio for students where there 
is a fairly equal number of 
Observations, Conversations, and 
Products.   

Choose whether this assessment will 
be summative or formative.  
Summative assignments count 
towards the report card grade while 
formative assignments do not count. 
You can change this at any time in 
the future should new data 
necessitate the change.   

Diagnostic and other are also other 
choices; they do not count toward 
the report card mark. 
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Marking an Assignment (OLD, use Touch Marks Entry when possible) 
First you need to find the Marks Entry by Assignment screen where you see a list of your students and 
are able to input marks. There are a variety of ways to find that screen. 
 
 
If you just finished creating an assignment, and pushed the save and go enter marks button, you are 
already there.  
 
 
 
 
 
 
 
If you are just opening the program 
 
 On the Assess tab, under the Classroom tab, choose Input marks by assignment. 
 
 
Step 5: Choose the mark you wish to enter, for each student, via the drop down arrow.   

 
 
The above picture shows mark entry by assignment. 

The full print out for the 
Achievement Key can be 
found on the SRSD 
website under teacher 
information, ILD 
department, and 
Students Achieve. 
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The picture below shows mark entry by student.  
On the Assess tab, under the Classroom tab, choose Input marks by student. 
 

 
Click the SAVE button to save marks entered by student! There is no auto-save in this entry 
method. 
 

Will Plan Classroom Assignments go away? 
Yes. We have been using Students Achieve for 6 years at the start of the 2015/16 school year. Software 
gets updated…any part of Students Achieve that has the word ‘TEACHERweb’ in the URL of the site you 
can expect to disappear in the coming 2-5 years. The pages with ‘UASweb’ in the URL are ones that are 
new and will stick around for a much longer period of time.  Students Achieve renewed the touch marks 
entry portion and will renew some features with regards to folder creation and overall views from the 
old screens next.  
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Exporting 
Getting marks from Students Achieve to Maplewood is called exporting.  

Your school administrator will advise you as to your individual school’s preferred export options.  

Exporting Options  
• Any teacher can export all their marks, class by class, or strand by strand. At any time. 
• Any principal or students achieve administrator can do the same, but can do all teachers one by 

one. 
• The division office can export the whole school with one button click.  

The key to success with multiple people available to export at multiple times is to keep the data up to 
date in Students Achieve. It is dangerous to change a mark in Maplewood after an export and expect 
it to stay changed – any re-export by your admin or division will overwrite any changes you make in 
Maplewood. Therefore a good rule of thumb is to change the data in Students Achieve only, and re-
export to get what you want in Maplewood. 

Note: The marks that will export are those that show up on a marks verification report. It is always wise 
to check that report first so you are not wondering why something didn’t export. Either it wasn’t there 
in the first place to export, or there was no connection to Maplewood to export with.   

 

Step 1:  From anywhere in Students Achieve, Using the tabs at the top of the screen, Click the Assess 
tab, Report Card tab, and choose Report Card Export.

 

 
Step 2:  Choose the term you wish to export.  
(Do not push the review button yet – it just goes to Maplewood, you want to export first!)
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Step 3:  After selecting the term, a new button will appear, Export All Ready Marks - click it. And Wait. 
The Big Export button will remain grey while it is working. (I have never checked off the overwrite marks 
that were previously copied button, it does overwrite anyway) 
 
 
 
 
 
 
 
 
 
 
 
When your export is complete, and the big Export all Ready Marks button is no longer greyed out you 
can go to Maplewood to see what landed. The shortcut to Maplewood is Enter Comments and Review.

  
To see how it is going, or conversely to export at a smaller granularity; while your Export All Ready 
Marks button is greyed out, you may click View Details for Each Class Section button. 

 
 
To export individual classes, just 
hit the circled export button on 
the class you want. 
 
To export individual strands, click 
the show details button on the 
class, and then multiple export 
buttons will appear – this is 
handy if you forgot work habits 
marks and want to export just work habits. 
 
The Airplane icon means it is exporting….the red x means it’s finished. (Yes red X is good) Occasionally 
you will get a green check mark when it is finished. Either way, red X or Green Check, both are good, 
both mean done. 
 
If the export button is greyed out and you want to export that strand, it is not available in Maplewood, 
talk to your school secretary to ensure topics are selected. Use the word topics, it will help the secretary.  
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Maplewood 

Comments 
Once you leave Students Achieve by clicking the 
“Enter Comments and Review Report Cards”, you will 
be automatically redirected to Maplewood.  

Then once inside Maplewood, we: 

• Enter comments 
• Spell check comments 
• Do programming codes (Grade 1-8)  
• Print and save the actual report card. 

If you are unable to do any of this, if any boxes are greyed out, it is a Maplewood issue, not a Students 
Achieve issue. Tell your school secretary, they can unlock the term and make it work. 

Entering Comments  
 
Choose marks/comments by student or by student or by class.  

 

The following screen will appear for the class. Student is similar. 

c 

The Comment  box on the report card is titled: STRENGTHS/AREAS OF WEAKNESS/NEXT STEPS: 
So please write something that will correspond with those three areas. 

  
  
 Choose a class 

 To type a comment for the whole class, use the drop down box to choose things like: Name, 
which will automatically pick the right name, or He/She or himself/herself.  

 Click the all under Apply in the column by the student names 

 To enter comments that will be applied to all students, do not use the tiny notepad icon beside a single 
student, instead click the topic title and you can make comments for the whole class for that topic.  

The teacher resource icon has help 
documents for Maplewood. Once you 
know this, click the Don’t Show again 
to get you to bother you.  

The teacher resource icon has help 
documents for Maplewood. Once you 
know this, click the Don’t Show again 
to get you to bother you.  

Ensure the Topic says ALL if you 
want to see all of the topics. All 
classes grade 1-12 will have the CSL 
topics and a subject level set of 
topics. Ensure you are looking at the 
correct term. 
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To enter comments, click the tiny notepad with the green plus sign for an individual student. 

To enter comments that will be applied to all students, do not use the tiny notepad icon beside a single 
student, instead click the topic title and you can make comments for the whole class for that topic.  

 

You can use the context sensitive word drop down to choose generic terms that will pick up the students 
correct spelling of their name and gender specific items stored in Maplewood.  

There is an ABC check icon in the lower left that can spell check.  

v 

The mint green ones are main 
topics and the muted forest green 
topics are sub topics. We put 
comments in the main subject topic 
only. The main topic should be the 
only topic with a comment icon. The 
sub topics are the only ones 
Students Achieve puts  marks into.  
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Programming Codes entered in Maplewood  
Programming codes are to indicate Regular grade level outcomes, Below grade level outcomes, French 
Immersion, or Individual Program Plans. We use programming codes in grade 1-8. Programming codes 
only print on Term 1, 2, 3 report cards, they are not a part of semester based report cards. If your grade 
7, 8, or 9 students are timetabled by semester, you will not be using programming codes and must 
comment accordingly. Kindergarten students are never below grade level as it’s the bottom level, 
therefore we do not use programming codes on Kindergarten report cards either. Parents will already 
know if their child has an Individual Program Plan and comments can refer to it if needed. 

Programming codes are completed in Maplewood, and are therefore not a part of any export from 
Students Achieve to Maplewood.  

The previous page has a picture of the topics where you can enter comments. The first topic pictured is 
programming codes, simply click in the box and choose your program code.  

You can autofill….ensure your cursor is in the top box and that it has the mark you want in that top box. 
Then click Shift+Ctrl+ down arrow. This appears in a pop up box on the  

NOTE: All of your marks should be there once it has exported from Students Achieve, It auto exports N/A 
for strands you have no results for. You will only have to enter the R for Regular, BGL for Below Grade 
Level or IIP for Individual Intervention Plan. 

 

Printing Report Cards 
Printing Report Cards from Maplewood. 

Maplewood has an office side and a teacher side. Teachers can print from the teacher side, secretaries 
and administrators can print from the office side. The office side is much more robust – if you are having 
troubles simply request your secretary print from the office side for you. 

Students Achieve does not print a report card. You need to leave Students Achieve and proceed to 
Maplewood to print your report card. To leave Students Achieve click the Enter Comments and Review 
Report Card Button 

 

In the Maplewood Achievement menu, look for the icon that says Print Report Cards. 

 

When you push that button, you will get a screen like the one below. Choose your name from the list 
and ensure the report name is the one you want. There MAY be different ones at your school, there may 
be only one. You can also check or uncheck students to print only selected students. Then simply click 
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view, this will get a print to the screen. You still have to click the printer icon in adobe acrobat to get it 
to print to paper after that.  Your school ALSO NEEDS TO develop a protocol for saving as well as 
printing. It is suggested that you save a copy in a central drive such as the L:/pool folder at the school.  

 

 

There is an option for printing double sided, it appears under the report date, choose Duplex. Duplex 
will add an extra page to odd numbered cards so that cards are either 4 or 6 pages long and it is possible 
to double side. Choose double sided printing on the printer when you print as well. 

 

OMG do I have to wait forever for it to print? (June 2015 – seeking resolution) 
If you click the view button as normal and your report takes longer than 3-5 minutes, then close the 
window, and hit cancel.  

The very next time you go into ‘Print Report Cards’ the pdf it was 
working to generate will just be there for you. 

There is a support video for printing on the Integrated Learning 
Department Website. It details steps for printing including what to 
do if your report is taking forever…close, cancel, walk away…next 
time you come back it will be waiting for you. No incessant clicking 
– that’s what makes it take longer.  

 

Saving Report Cards 
Report cards must be saved. It is the secretary’s job at the school to save the whole school for that term. 
She must save it in a special report card folder that is accessible to division office personnel.   You are 
welcome to save a copy yourself but the school copy will always be there year to year. 

On your school’s Apps on I drive, there is a folder called ReportCards, and it has yearly sub folders. That 
is where copies of past report cards are to be saved.  

  

Choose your name 
from the list. 
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Secretary Section – Under Construction 
_____________________________________________________________________________________ 

The role of the secretary is different at each school. At the beginning of a class, the secretary must select 
terms and topics for classes that she has assigned to teachers and timetable students. The secretary also 
manages the terms. She must unlock a term when a teacher needs to enter comments and for exports. 
She must lock previous terms after report cards have printed.  At some schools the secretary prints 
report cards, at other schools the teachers do. Regardless, every secretary must save a copy of the 
report cards after printing.  

Current year instructions (not scheduling year) 

Create Classes from Courses   
(If you are missing a course call Joyce/Brad/Asha) 
In the menu choose File>School Set up>Classes.  Now you can make classes off of a course. 

*Note:  You can add staff for next year and assign them to classes now. * 

Things to attend to: 

- Click Add 
- Pick the teacher for the class, section a is the first teacher that teaches that class, if you have 

two teachers that teach say, Math 2, then you’ll need a Math 2 section b…maybe even section c 
if there is a third. 

- assign the ‘students achieve pattern’ for the schedule. 
- Ensure the CREDIT VALUE = 0.0 (if it is a non high school credit course) 
- Ensure Reportable is checked (should be defaulted) 

Click ADD to enter another class over and over until you are done.  

Click OK when you are finished. 

For split grades you can create excursion lists and add by list.  

You must add students to their classes when they enter the school, every time you get a new student, 
he/she must be timetabled. This is something you do continuously all year long. You can add an 
individual student by clicking individual student instead of assign timetables by group in the edit 
timetables menu, OR edit on the timetable tab of the student record itself. 
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Selecting Terms 
Click Marks>Topic Based Marks> Select Terms. 

Click Filter, Click OK, all the courses will come up. Add T1, T2, and T3 as terms, and you’re done. It 
should look like this: 

 

 

 

 

 

 

 

 

Selecting Topics 
In the Marks Menu Choose Topic Based Marks>Select Topics 

Click Filter – and think about how you want to proceed. You can simply click OK next and the entire list 
of courses will populate. You can then go through every class one by one selecting the topics by 
checking the three appropriate topics for that class, clicking select, and moving on to the next class in 
the drop down  

– OR – to be more strategic: Click Filter, course filter, and filter to get all the art classes up by typing art* 
- then you can choose the three appropriate topics for art (programming, characteristics of successful 
learners, and art) and Assign to all. 

Every class needs a red check mark beside the topic programming and characteristics of successful 
learners and the appropriate subject topic assigned to it.  
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De-select topics for PAA 
To unselect a topic for the purpose of ensuring PAA prints correctly on the report card: 

In Maplewood: 

• Marks>Topic Based Marks>Select Topics 
• Click Filter 
• Select Course Filter  and type PAA*  - this will get your PAA7 and 8 classes. 
• Uncheck the ones under PAA that you don’t want and assign to all. You can only use assign to all 

if your all list only has PAA classes in it like the picture below. If you didn’t filter your courses, 
don’t do assign to all. 

•  The ones with red checks will print, the ones without will not.  
 

 

 

 
• Enter names and ok – to add more names click Add.   

Printing Report Cards 
 
Some schools the teacher prints from the teacher side, however it is much more efficient in many cases 
to have the secretary print from the office side.  

Choosing the right report card to print. 

• Choose the correct term, the division will assist with this by only making available current terms. 
• Kindergarten has their own report, choose it for English Kindergarten students. 
• French Immersion K,1,2 has their own report, choose that one for French Immersion grades 

K,1,2 only 
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• Elementary grade 1-8 in K-8 schools or 1 and up as long as they are timetabled in T1, T2, T3 
classes. Print the T1 or T2 or T3 report. 

• There will be four reports for high school, S1T1, S1T2, S2T1, and S2T2 
• Wesmor is special. (they have 5 blocks or 10 terms) 

 

In Maplewood: 

• Marks>Print Report Cards>Report Builder for Report Cards 
• Select the folder  in the left column (1) 
• Select the report you wish to print by selecting it blue (2) 
• Push the blue play button (3) 

 
 
 

 

Check off the page padding, to duplex prior to running. This will make double siding possible because it 
will insert a blank page after odd numbered page student report cards. 

If you click the Run Report button now your whole school will generate in one report. This can take an 
hour even at a small school.  But you can just let it run while you do other things.  

If you are a large school consider: 

Click Add Criterion, and choose Homeroom, and pick a homeroom, then RUN REPORT just for 
that homeroom. This will yield smaller files, but you’ll have to do it for every homeroom 

When the report cards appear on the screen. That is when you have to choose FILE>EXPORT TO PDF. 
You cannot just hit print. 

Choose the printer and print on letter size paper, double sided, and hand staple after the big lot comes 
out. 

Saving Report Cards 
Report cards must be saved. It is the secretary’s job at the school to save the whole school for that term. 
You must save it in a special report card folder that is accessible to division office personnel so that 
school psychologists etc. can access past report cards. 

1 

2 

3 

48 |  J u n e - 1 5  
 



After each term, Repeat the print process if needed to get a PDF copy of the report cards up.  

Save the resulting PDF file(s) electronically in the I:/pool/report cards folder. This  location will be 
available to all division staff and in years to come, that is why it is important you use that folder. 

Save a pdf copy of the report cards NOT a prnx copy as comes out if you choose print instead of export.  

Correlate Database 
There is an office side to Maplewood and a teacher side. You look at the office side…they look at the 
teacher side. If they are ever different, Correlate your database. How often should you do this? At the 
end of every day that you have made timetable changes. Don’t expect to have your teachers see new 
kids in their classes, new classes, different sections etc. until you Correlate.  

After performing a correlation, then you must wait overnight for Students Achieve to reflect the new 
information. If it is emergent that a teacher see the changes, call Debbie Hobson for an integration. 

Integration 
Maplewood sends data to Students Achieve nightly. In an emergency (report card day) you can request 
that process happen instantly. Not every secretary has the rights to integrate, call Debbie Hobson if you 
do not have this ability. Detailed instructions are in the Expert Section.  
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Expert Section  
_____________________________________________________________________________________ 

Each title below is a tab in Students Achieve, each subtitle is a sub tab. Then each item under the tab is 
described.  

Manage Tab 

Setup – School Schedule 
Under the setup tab, click School 
Schedule item. 

You have to configure a track, 
cycle, and calendar – three items 
numbered 1,2,3. 

Unless the current year has a 
green check mark, people cannot 
use Students Achieve for the 
year.  

If there is a mistake, you can 
unsubmit, fix it, and re-submit. 

Students Achieve gets its data 
from Maplewood, so once your 
school year is setup, changes in 
MW should be reflected in SA.  

 

 

For each step 1,2,3, click the words: Configure your track, 
cycle, calendar to do each one. 

Complete each pop up box as outlined in following images 
and click the Submit button when complete. Your checkmark 
will be green instead of a red x and you’ll know you are set 
up. 
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For Step 1: Configure your Track use the New icon to create reporting periods and enter the appropriate 
dates. It will not let you overlap dates. Click SAVE when done and close the window. 

 

 
For Step 2: it should say you need at least once cycle to start. 
Click the words ‘Configure your Cycle’ and click create default 
cycle.  

 

That button turns grey, and you wonder, what did I do, you created a default cycle, it’s done, close the 
window. 

Then it will say you need to regenerate the calendar. Click the blue ‘click here to regenerate calendar’ 
link. 

 

Click the regenerate button and click OK on 
the pop up box. You will then get a 
calendar. It automatically pops you into 
step 3.  
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Step 3: A calendar will pop up. Click on 
the first day of school and you will get a 
brown pop up box like the one pictured 
here. 

Click on the Bulk Fill Tab.  

Click on School Day so it is Blue 
Highlighted. 

Click Rotate to End. 

 

 

You will know it worked when your calendar 
has blue days on the whole year instead of 
nothing. 

 

Close that window, hit the Submit button. Your 
school year will now have a green check mark 
on it and the teachers and classes will appear 
for that year.  
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Classes – Subject Resolution 
Under Manage>Entities, look at the Subject tab. If the subject you are looking for is there, move over to 
the Subject Resolution Tab of the three Tabs. If the subject you are looking for is NOT there, you will 
need to use the ADD icon, to add a subject. Adding High School Subjects, the subject and the 
specialization are both identical.  

To add a subject resolution, choose the correct subject from the main subject drop down list FIRST and 
then  click the add icon.  

 

The following box will pop up. Choose the school board, school, and double check the specialization. 

 

 

 

 
 

 

 

 

 

 

 

 

Type in the MW course topic code from the MW Topic Codes for the division in the class ID profile.  

Put % in the other two boxes and click CREATE.  
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Classes – Class Configuration  
Teachers have this as well, there are more detailed pictures in the teacher section.  

• You can change the display name of the class for a teacher here in the class label box.  
• You can de-initialize a class so it can be re-set up. This process WILL DELETE all marks and 

assignments. If a teacher has the wrong outcomes for the class, this will need to be done. 
o Click the Tools/Utilities tab, click the remove all class content button. 

 Click NEXT, NEXT, Check the YES I really want to delete button 
 Click the Delete all class content permanently button. 

o Now the teacher can go re-initialize their class. 
• You can share the class with another teacher (in teacher section as well as teachers have this 

ability)  
o Click the sharing tab 
o Click the new icon 
o Choose the teacher to share with, click done.  If the teacher you want is not in the list, 

check the filter by date box, and they will appear as a choice. 
• You can see the enrollment for a class in the enrollment tab. The list of students will be there, 

that is one place where you can check or uncheck the ACTIVE column. Students that are no 
longer in Maplewood will be unchecked or de-activated. If you need to see an old student in a 
class to get marks, you can check the ACTIVE box and hit save. This will remain active in one 
class for one day until integration de-activates them again. 
START UP TIP: 

• You can delete classes from your school. This is a wonderful idea to do after you have your 
courses set for the year and before the teachers start fiddling. Every class since rollover is in 
there; sometimes in duplicate. If you check off all classes, and hit delete – the ones that have 
not been used will go away and only the right ones will come back after integration that night.   

o Check the top box so that all boxes are checked beside the number on the left.  
o Click delete, it will turn them yellow and say are you sure? – yes – and they delete. 
o Perform an integration or wait overnight and only the correct ones will come back. 
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From the above picture, I can tell that the STATUS of the Homeroom B is Shared, The S indicates this 
class is shared with another teacher. This is odd for a homeroom, but very normal for an Arts Education 
class where one teacher has music and another the visual arts. Once you have completed changing a 
class to shared status, REFRESH this webpage to see the {S} in the status column to know you have been 
effective. 

The other very important thing I can tell from this screen is that the first few classes, Arts 2a, 5a, 1b, 2b, 
4b, have the underlined word Initialize beside them in the Template column. This means that the 
teacher has NEVER ever opened up that class.  

De-initializing  
Manage>Classes>Class Sections 

If a teacher has started off the year incorrectly – they 
do not have the curriculum they need or the template 
they need, we must de-initialize or clear the class 
completely so the teacher can re-initialize. 

Click the paper pencil icon beside the class name to 
get the following pop up to appear. 

Click on the Configuration Tab. 

 

Then the Tools and Utilities Sub Tab. 

 

 

Then click the remove all class content button.   
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A pop up box asks if you want to clear all class 
content – click OK. 

Click Next, Next Again, and check off the box that 
says you really want to delete content for this class.  

If there are also RED words that say “This class has 
marks”, be absolutely sure you have communicated 
with the teacher prior to deleting, this cannot be 
undone.  

 

Then click the button at the bottom that is almost 
hidden at the bottom of the screen in Internet 
Explorer. To see this full button maximize the 
screen, or use Chrome.  It says “Delete this class’s 
content permanently.  

 

 

When you close the pop up boxes and refresh your screen then you will again get the ‘initialize’ link 
rather than the template that was previously applied. 

Entities – Launch School Integration 
Maplewood and Students Achieve talk every night, unless you push this button forcing the 
communication to happen instantly. Ensure you correlated your database in Maplewood prior to doing 
an integration. 

Click Manage>Entities>Launch School Integration 

Click the Import School Data for XXX school button.  

It is finished when it appears in completed requests. If you accidentally clicked launch twice, cancel the 
waiting requests if they are not needed. 
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Mass Export 
You will have multi-school authority, use it carefully, only export your whole school. 

Assess Tab>Report Cards>Mass Export Manager 

 

 

Choose the correct term and school, and push the blue triangle play button 
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Click the Export All button and watch as the screen flashes. Wait until you see the # of strands exporting 
go down to 0 (finished) and ensure the number of strands configured and exported matches. If it does 
not, click show errors and read them. If you don’t know what to do with the information, call for help. 

 

Managing People  
Under Manage, People, Teachers – You can see who has teaching duties at your school.  

You can add interns here. They will not appear in the list when done, but they will be there to share 
classes with, and once they have classes, then they will appear in the top list. 

To add a teacher (only add interns, and make yourself a reminder to delete the intern after they leave): 

 

Click the New icon 

Type in the first name, last name, and email address, and the add 
this teacher button. 

 

In the Maintain Teacher popup, in the last line you 
will see the Windows Account line. 

Enter the following: 

Srsd119\username 
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1.) 

Use their actual username. This will enable auto login. 

Ensure there is only ONE person, don’t add two of someone or their login won’t work.  

 

IF YOU MADE THEM, YOU DELETE THEM. When an intern is no longer an intern, who deletes their 
account? YOU DO, IF YOU MADE THEM. My trick is to give Interns the first name “Intern” and the last 
name their Full Name. This enables searching for all people with first name ‘Intern’ to easily find and 
delete them.  

Assess Tab 
Assess Tab items are all in the teacher section of the manual.  Report card export is the place that you 
can export an individual teacher or individual class. Transfer student marks is here as well. 

Analyze Tab 
Analyze>Additional Reports>Run Reports is where you can get usernames and passwords for parents. 
Detailed instructions for getting the report out of SA and into a mail merge start on the next page of this 
document.  

There are many reports of little value to us in this area. One that we use is the SRSD Metrics Report. 

This report can be run for a whole school or just one class. Once you choose that it will ask a threshold 
for observation.  

Choosing 1, will tell you if the outcome has been taught at all, choosing 3 will tell you if there are at least 
3 pieces of evidence for that outcome. You can run the report by strand by typing in the strand name, or 
leave it blank for every outcome.  

 

Steps to get a whole class student/parent portal passwords: 
 

1.) Analyze> Additional Reports>Run Reports 
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4.) 

3.) 

2.) 

5.) 

 

2.) Plus Sign the Access Passwords Reports  
3.) EASY OPTION: Choose Parent Reachout by class – choose one teacher at a time, choose only 

contacts rather than all or students at the end. Choose suppress cover page. You will get a pdf 
with one page per parent – if you don’t like what it says, choose word and change it. 

4.) HARDER Aesthetically pleasing option: Choose Student parent HTML Password Report (easy 
option you can skip steps 12-28 – mail merge….not as clean and simple looking, but same 
information) 

5.) Choose the correct year AND choose a teacher  
6.) Click Next 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

7.) Choose the Homeroom class for a whole class list by teacher 
8.) Click Next 
9.) Keep all students highlighted blue and hit process report.  
10.) A pop up will appear – it will say queued…wait…it will pop up on the screen looking like this. 

 
11.)  In the file pop up window. Click File>Save as – and give the report a name and save it in a 

location you can find it. It will be an .htm file.  
12.)  If you are doing the whole school…back in Students Achieve you can just hit back, back and pick 

a new teacher…next…and a new homeroom…next…and process again and save again. 
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Now you have an .htm file for every classroom in your school. We need to convert them to .xls files. 

13.) Open up the program MS Excel. This spreadsheet software must be open before you open the 
files. 

14.) Inside MS Excel…choose File Open and open up your .htm file(s) 
15.) With the file open, Choose File>Save as – and change the file type to Excel Workbook and save 

the file. 
16.) Close the file. You don’t need Excel anymore. 

Now we will open an existing Word document that can be downloaded from google apps or emailed to 
you from central office. It is ‘entitled parent engagement letter’ and link it to the spreadsheets to get 
the passwords to come out one per person.  

You can also complete an EMAIL merge in MS OUTLOOK because this report now contains email 
addresses as well. 

 

17.) Open MS Word and open the Word 
Document. It will most likely give a 
message like this. Say yes. 

 

 

 

18.) The open document has links to 
spreadsheet columns.  

 

 

19.) In the Mailings tab, click mail merge, and step by 
step mail merge wizard.  
 
 
 
 
 

20.) The mail merge menu will appear on the side 
screen. 
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21.) Select a different list and go find your desired class .xls file and open it. 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

22.) Then click OK to link the files and 
you should get a pop up like this. 
 

23.) Click Filter.  
 
We are going to exclude the 
Students for the Parent print. 
 

 

24.)  In the Filter pop up box use the 
drop down arrows to choose: 

a. Field: Person_Type 
b. Comparison: Contains 
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c. Compare to: M or F or G or add contains both M and F… 
The parents now have a person type of M for mother, F for father, and G for guardian even 
though the picture has a  

 
 

25.) Click OK, and then OK again. 

 

 

26.) Click Next Write your letter in the mail merge side bar. That 
is step 3 of 6. 
 
 

27.) Click next for step 4 of 6 and 5 of 6 as well.  

 

28.) Click Print and choose a printer to print out a page for each 
parent with their username and password on it.  
 

29.) Print all pages. 
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FAQ 
 

What is the difference between Students Achieve and Maplewood? 

Students Achieve is a grade book that supports rubric marking and growth in that it does not average 
assignments and gives us the most recent mark per outcome.  It has online engagement pieces for 
parents and students,  

Maplewood is a student information system that facilitates the taking of attendance, has student data 
and parent data, and is able to hold written comments. It prints report cards. It had a grade book part to 
it, but the grade book has no way of representing current assessment practices, therefore we use 
Students Achieve for the grade book of it and export marks from Students Achieve into Maplewood to 
print. 

Therefore, the most common misconception is stated factually here: There is no Students Achieve 
Report Card.  

Do I have to have all the CSL’s marked for every subject every term? 

Yes. We believe that students act or behave differently in different subject areas with one teacher, and 
in different teachers’ classes. This data is recorded with the outcome marks in every class grades 1-12. 
In Kindergarten, the CSL’s are different. They are housed in the ‘social studies’ class for lack of a better 
place to put them, and they print on the front of the Kindergarten report card for the whole child.  

My social studies CSL marks printed first, then the other courses printed with no CSL marks, how 
come? 

You have printed the Kindergarten report card instead of the grade 1-8 or 9-12 report card.  

Is the little notepad icon visible to parents in the parent portal?  

No. As of Sept 1 2015, it is not. We have it turned off currently. 

Is professional judgement visible to parents in the parent portal?  

No.  Of course if a student has 4 marks at a 2 level and you use your judgement to move that to an 
overall mark of 1…a parent could (and should) ask why? If you truly believe a student is at a 1 level, then 
mark them that way in the first place. Professional judgement is the exception, not the rule.  We have 
already set the calculations to professionally reflect best practice in assessment. You should have a 
defensible reason for applying it that you can easily share with a parent that asks. 
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How do I, or do I have to, print a report card for a student who has left? 

We print report cards from Maplewood. The minute a student is removed from Maplewood, we can no 
longer print a report card for them. If we know they are leaving, export and print before removing them. 
If we do not know they are leaving, then there is nothing from Maplewood you can print. Secretaries 
cannot keep kids in Maplewood until you are ready to print, the Ministry mandates they be taken out 
within 48 hours of the student leaving.  

If you are asked for a report after a kid has left Maplewood, then your only recourse is to print a report 
from the reports section of Students Achieve. You can use the Student Collapsed Term Summary report 
to get the same data a report card would have. It just won’t have any attendance or comments. If you 
would like to comment, type and attach something in MS Word.  

If a student transferred to another SRPSD school, it is not necessary to print anything, the new school 
can import your data and print.  

There are no marks to transfer and yet I think there should be some. Why? 

If you teach a math -7 class, and you have a grade 7 student transferring in from another SRPSD school, 
you can transfer marks from any other math – 7 class out there. However, if that student was in a 7-8 
split class, they might have actually been enrolled in a Math – 8 class, which you cannot import from. 
Ask the previous teacher to email you a student summary report in this case.  

Why does Students Achieve keep going down? 

Actually, Students Achieve itself has never gone down. It is the shortcut between Maplewood and 
Students Achieve that will stop working frequently during high volume times. Part of this is user error. 
We can all help by not double clicking!  

IF you are not auto-redirected, when you click attendance or review report cards, the ‘shortcut’ to 
Maplewood is down – neither Students Achieve nor Maplewood is down, just the shortcut.  

We have long advised people to simply use the Maplewood links in the Staff Room web page if the 
‘operation times out’ but now there is also a link right in your error message pop up screen so you can 
log into Maplewood. The only function that ‘goes down’ is the auto login feature, and it does this 
because of excessive clicking during attendance and high volume report card times. Click once and 
wait….multiple clicking can break the shortcut for everyone. If you notice it down please call tech 
services, it resets itself every morning and lunch hour, but we can reset it manually as well.  

When I click the link to go over to Maplewood it goes to the previous school I was at. How do I fix 
that? 

Have your secretary call your old secretary to have you removed from Maplewood at the school you no 
longer teach at. 
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When I click the link to go over to Maplewood I only get one school…but I teach at three schools. 
What do I do? 

The shortcut can only handle one school, you will need to go to the Staff Room web page and log onto 
the correct school via the posted Maplewood links. You can put multiple different shortcuts on your 
desktop to the correct schools for handy access. 

Why can’t I see the percent for high school at any point in the year? 

Simply put, because we turned it off. The assessment beliefs of SRPSD support student learning. We 
want students focused on outcomes and teachers focused on assessing the attainment skills and 
knowledge levels with regard to the outcome statement, not in comparison to a scale. There are no 80% 
kids, and a 50% does not mean a student is ready to tackle the next level course. Speak to your principal 
so that he/she may explain the philosophy more clearly or approach a superintendent about change. 

 
Where can I find online information to help me with Students Achieve? 
Go to SRSD website and click on “Teacher Information”, click on “Integrated Learning Department”, click 
on “Students Achieve”…here you will find many instructional videos and documents that can help you 
with Students Achieve. 
 
Where do I write my comments for the Student Achieve report card? 
Comments are written in Maplewood not in Students Achieve.  Marks and Characteristics of Successful 
Learners entries completed by teachers in Students Achieve at the end of reporting periods are verified 
by teachers and then exported into Maplewood by admin.  The new SA report card is printed out of 
Maplewood. 
 
Is there a limit to the length of the comments I can write in Maplewood? 
For grade K-9 teachers using Students Achieve there is no limit to the length of the comments that you 
can write for a student in Maplewood.  Do NOT worry if it says “exceeds comment length”, or if your 
comments turn red.  There is NO set comment length for grade K-9 classes reporting with the new 
Students Achieve report card.  (This is for grade 9 classes only; grades 10 – 12 MUST follow the comment 
length warnings.) 
 
How many times per reporting period should I assess CSLs for each class? 
All students must have all four CSLs entered in Students Achieve in EACH reporting period.   Students 
must be aware of the CSLs that they are being assessed on, this can be achieved by adding a CSL to an 
assignment rubric or using a separate CSL assessment sheet which can be found by searching in goapps 
or on the students achieve help site.  These are characteristics that we want all of our students to 
develop and show growth in.  CSLs can be incorporated with assignments where you see fit or assessed 
as a class. Assessing CSL’s on a cross curricular assignment can be very efficient for younger grades. 
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Can I leave the CSLs blank for a student that has not been attending regularly? 
NO, you must enter “Rarely” for all CSLs as worst case scenario so the CSLs are not blank on the report 
card.  You may want to make a comment in Maplewood explaining your CSL entries for this student in 
this case. 
 
If a student has not shown any understanding of a number of assessed outcomes (due to poor 
attendance or very poor performance) what do I do then? 
If you were not able to assess any outcomes in that strand at all for that student, then the strand mark 
will be blank.  When the report card prints, a N/A will show up on the report card for that strand.  Your 
comment you put in Maplewood should explain the N/A.  On your Marks Verification Sheet there will be 
a blank beside that student’s name for that strand so you must initial your verification sheet in the blank 
so that we know you intended that strand mark to be blank. 
If you only have say 1 outcome assessed in that strand out of say 5 outcomes for that student ( same 
reasons as above or late registering in your class) the mark for that outcome will show up as their strand 
mark and also on their report card which can be misleading. If they have a 3 on that one outcome but 
have not shown any understanding in the other four outcomes your comment must reflect that they 
have only completed the one outcome out of 5 because a mark of 3 will show up on the report card. 
 
For the midterm report where some strands have not been taught yet, do I have to enter N/A across 
the board for all students in my class for those strands not covered yet? 
No you do not, you just leave outcomes and strands not covered yet blank.  A N/A will print out in all of 
those areas on the report card.  On your verification sheet strand columns will be blank for the strands 
that you have not covered yet.  Prior to handing in your Marks Verification Sheet you need to initial all 
blank columns of strands that you have not taught or assessed yet 
 
In Students Achieve when entering marks for assignments/outcomes you can put in various 
abbreviations instead of a mark depending on the situation. ( Ex NHI – not handed in, INC- incomplete 
etc.)  will these show up on the report card? 
No, only the strand mark that you decide on for all the outcomes within that strand will show up on the 
report card.  The abbreviations you enter in Students Achieve, if you choose to, can be printed on an 
assessment summary – the last report in the list of reports in the student analysis section. This report 
can be very valuable to older students – and can be sent home at times other than report card time to 
be most effective. 
 
In Maplewood when I go to write my comments for each student, there are a bunch of other topics 
listed there. (Example Characteristics of Successful Learners etc.)  Do I have to write comments in all 
these areas? 
No, you only have to write your comments in the subject area topic.  This is the only topic that you can 
click on and actually write your comments.  If you click on the other topics listed you will find that you 
are unable to write anything anyways- or at least this should be the case. 
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Vocabulary 
 

Integration  --  the nightly process of Maplewood sending data to Students Achieve. New teachers, 
classes, and students come from Maplewood to SA nightly. 

Grade Book – the data kept by Students Achieve. 

Export – the process of getting marks that exist in the gradebook (students achieve) out and into the 
report card generator (Maplewood) This is a one way process that takes overall strand marks from SA to 
MW. It can be done for the whole school, one teacher, one class, or one strand inside one class. If you 
do not see a mark in SA inside the overall result for that term, no mark will be exported. If there is not a 
matching topic in Maplewood for that term, no mark will be exported.  

Report Card – a document generated and printed by Maplewood.  

Correlate – a secretarial process that aligns the admin side of Maplewood with the teacher view. 
Performed daily during periods of timetable changes.  

Accessing this manual online 
It is prudent to use the most up to date version of this manual; the date is on each page by the page 
number. If your paper copy is old, check online in one of two places for an updated version.  

1.) Search the SRPSD website for ‘students achieve’ or visit the Integrated Learning Department 
webpage by clicking 
 Teacher information 
 Integrated Learning Department 
 Students Achieve 

2.) In Google Apps, type Students Achieve Help in the search bar, and BEFORE you hit the blue 
search button to search the entire web…. 
 Click the tiny down arrow, 
 Check the box “students.srsd119.ca” to just search our site 
 Click the search button. 
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Who do I call for help? 
In Google Apps, Search “Students Achieve Help” There are a multitude of videos and documents to 
support you. Type your search and use the tiny down arrow to search only SRPSD. 

First level support is in each school: Teachers ask their school secretary for Maplewood issues and their 
school administrator or students achieve expert for Students Achieve issues.  

Second level support: Secretaries call Debbie Hobson, Administrators/Experts call Sheri Gunville. 

Third level support: Debbie contacts Sheri or Brad on behalf of secretaries.  

Handy Contact Chart: Try the Manual first!  

Sheri – sherig@srsd119.ca 
764-1571 

Debbie – dhobson@srsd119.ca 
922-6446 

I am a teacher: I am a secretary: 
-I have never used Students Achieve (SA) and 

need training.  
-The software is not functioning like I think it 

should. 
-I have used SA but I forget how to….edit, save, 

delete. 
-I need to know how this calculates report card 

marks, or general assessment knowledge 
questions. 

 -If you have any issues around what you 
are teaching, which kids are in your class, 
what your class is called, or what grade has 
been assigned to it, ask your school secretary 
first. 

- I have consulted the help documents posted 
on the Students Achieve page as a first step. 

-I am having Maplewood issues – scheduling, 
putting kids in classes, getting the right kids in a 
split grade.  

-My Maplewood changes are not affecting 
Students Achieve. 

--Printing report card help  
-Saving report cards – assist secretaries with 

instructions  
-I can’t pick a date because it says it is ‘outside 

my school schedule’. 
 
 

I am a principal: I am a principal or Students Achieve expert: 
-I need an assessment refresher or technical 

training for my staff.  
-I have an emergency. 
-Export process and or troubleshooting issues. 

-I am ready for my export to happen 
 

Brad – Briddoch@srsd119.ca 764-1571 

-I have an emergency. 
-I have printing problems – display on paper does not match display on screen. 
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